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Copyright 1997-98 John Williams

Email: john@xrayz.demon.co.uk
x_rayz@cix.co.uk

Web: http://www.xrayz.demon.co.uk

What Is ClipCache?
ClipCache is an easy to use and powerful clipboard extender. Whenever you use the standard Windows 
clipboard to cut and paste, only one item may be placed onto the clipboard at a time. Thus, copying an 
object to the clipboard deletes the clipboard’s previous content. However, with ClipCache installed it 
quietly sits in the system tray, monitoring the clipboard. ClipCache automatically saves clipboard objects 
to the currently active group. Clips may then be retrieved minutes, hours or weeks later.

Unlike many other clipboard extenders ClipCache adopts a standard Windows look and feel (drag and 
drop, property pages, context menus for both group and item panes) and is highly intuitive. ClipCache has
been designed for various types of users. Those that wish to only navigate the clip history by the 
keyboard, and those that prefer to use the mouse.

The ClipCache main window is divided up into three separate areas (panes.)

· Group pane
· Item pane
· Preview pane

Clipboard Formats
Currently the only clipboard formats supported are:

Text: Includes OEMText and UnicodeText[WindowsNT only]
Bitmap Device independent bitmaps
Drop: Saves the names of files when ‘Copying’ or ‘Cutting’ a 

file in explorer.

Future versions will support more formats.

Freeware Notice
Even though ClipCache is freeware, many kind users have offered to make various contributions.I have 
refused all offers, that is, until now. As of version 1.40, anyone that feels they would like to make a 
contribution may do so. For further details please email me (at any of the above email addresses.)

If you intend to use ClipCache, all that is asked of you is to visit http://www.xrayz.demon.co.uk and submit
a feedback form. If you wish, you may leave the form blank. This is simply to assist in obtaining an idea of
the userbase.
 



Groups
Clipped items belong to groups. Groups help you to categorise and structure your clips. For example, you
may have groups for URLs, signatures, programming, research topics etc…

Each group has its own set of properties. For example restricting the size of the group to 100 items or 
maintaining the size of the group at 200Kb.

ClipCache maintains a special group called 'Trash' in which it keeps all deleted items until you decide to 
empty the trash. Items deleted from the trash group are permanently deleted.

If a group is active, this will be the group that will receive new clips when you do a copy operation from 
your application. Any group may be activated at whatever time you choose. You may organise items 
within groups by dragging and dropping items between groups. Even drag text from your text editor 
directly onto the group.



Items
The items pane enables you to view the contents of each group. Choose to view items as large icons, 
small icons, list or as a report. In report view Each clip item displays its name (which may be modified), 
the size and the date that it was clipped.

Items may be dragged and dropped directly from ClipCache to, for example, WordPad. Selecting multiple 
items enables you to merge the items into a single clip.

Click on a column header to sort the list by Name, Size, Format and Date (default.) Clicking on a column 
header that is currently sorted will reverse the sort order (ascending/descending). An arrow in the column 
header will indicate the currently sorted column and the order.



Preview
The preview pane shows you the contents of the currently selected item in the item pane. The font used 
to display text clips is configureable.



Running ClipCache

First Time Use
It is recommended to have ClipCache automatically load when you start a Windows session. When 
ClipCache is running you will see a ClipCache icon in the system tray (located at the end of the task-bar.) 
Load ClipCache if it is not already running. Note: you may only have one instance of ClipCache running at
any one time.

The first time you run ClipCache it will be configured ideally for the first time user. For example, it 
starts up with the main window open and does not allow you to put clipped items onto the 
clipboard by double-clicking the mouse button. As you become familiar with ClipCache you will 
most definitely want to change the default options. 

First create a new file in which ClipCache can store the captured clips:

· Select New from the File menu to create the file.

Using Groups
When a ClipCache file has been created you will be presented with two groups.    A ‘trash’ group and a 
‘new clips’ group. The arrow to the left of the group denotes the active group. As ClipCache monitors the 
clipboard activity it will add the clipboard object to the active group. Note, if you do not have the active 
group selected, you will not see the newly added item.

Each group has a set of configurable properties. To view the properties:

· Select the group and choose Tools | Properties (you may also use the right-click menu or 
the keyboard shortcut Alt+ENTER.)

Using Items
To put an item onto the clipboard, select it and the choose Edit | Copy (you may also use the right-click 
menu or double-click the item [if enabled in options.])

For access to frequently used clips it’s a good idea to assign a hotkey to the clip item. This can be done 
from the item properties.

To organise your items into groups, Items may be dragged from one group to another. Items may also be 
dragged to other applications, such as WordPad. Each item has its own    properties. Select the item and 
choose Tools | Properties (you may also use the right-click menu or the keyboard shortcut Alt+ENTER.)

See also: How To Organise Items

Hotkeys
Hotkeys are a quick way to access ClipCache and your clipped items. Configure hotkeys in the options 
dialog box to get the most out of ClipCache.

System Tray
ClipCache makes use of the system tray, see Using The System Tray for further information.



Item Properties: General

Displays the item’s name, format, size and date the clip was added to the database. ‘Source’ indicates the
window title from which the clip was copied.

HotKey
A system wide hotkey may be a assigned to the item. This will cause the item to be copied to the 
clipboard whenever the hotkey is pressed. Choosing ‘Reset All’ will remove hotkeys assigned to ALL 
items. Current hotkey assignment may be viewed by choosing View|HotKey Items Only.



Group Properties: General

Displays the group’s name, type, size and number of items it contains.



Group Properties: Purge

The purging of groups allows easy maintenance of the database size. Purge settings are configurable for 
each group. When you choose Purge All Groups these settings will be used in the purge operation.
 
Limit the number of items stored in this group:
Keeps the group’s item count at the value specified by moving older items to trash. This option may be 
toggled on or off whilst maintaining the chosen value.

Limit the size of this group:
Keeps the group’s storage size at the value specified (expressed in bytes, Kbytes or Mbytes) by moving 
older items to trash. This option may be toggled on or off whilst maintaining the chosen value.



Active Group

The active group is the group that receives all captured clips. There can only be one active group at any 
time. An arrow to the left of the group icon denotes the active group.

To activate a group:

· select the group, then choose Tools | Activate Group (you may also, use the right-click 
menu or double-click the group.)



Options: General

Enable display of clipped items in tray menu:
If enabled, when right clicking on the ClipCache tray icon, a menu will appear. The menu will display the 
specified number of items as well the currently active group name. Selecting an item from this menu will 
place it onto the clipboard.

Keep the window on top:
If enabled, the ClipCache main window will always be on top of all other windows.

Hide the window after copying a clipped item:
If enabled, after you select copy from within ClipCache, the main window will be minimised.

Activate window with this hotkey:
Setting this system wide hotkey will bring the ClipCache main window to the top. You may press ESCAPE
to dismiss the window without taking any action. Or you may choose to copy an item by using the mouse 
or keyboard. 

Double clicking (or pressing enter) on a clipped item copies it to the clipboard:
If enabled, you have an extra way to place items onto the clipboard besides using the standard EditCopy 
command.

Play this sound when capturing:
If enabled, whenever ClipCache captures a clip, a wave sound will be played. You may enter the filename
of a wave file in the box below. Chose the ‘Browse…’ button to help locate the wave file. If you do not 
specify a filename or it does not exist, a system default sound will be played (if configured in your 
operating system.)

Tip: the options below all work extremely well together for fast access to your clips without using the 
mouse. However, there is an even quicker method described in the advanced options.

‘Activate window with this hotkey’
‘Hide the window after copying an item to the clipboard’
‘Double clicking (or pressing enter) on an item copies it to the clipboard’



Options: Startup

Purge all groups after opening a ClipCache file:
If enabled, ClipCache will attempt to purge all the groups when opening a ClipCache file. Setting this 
option and setting up reasonable purge options will help maintain the size of your ClipCache groups.

Clear ‘Trash’ after opening a ClipCache file.
If enabled, the contents of the trash group will be deleted (permanently.)
Tip: Setting this option along with ‘Purge all groups after opening a ClipCache file’ will help maintain the 
size of your ClipCache data file.

Automatically open the most recently used ClipCache file:
If enabled, when ClipCache loads, it will re-load the latest ClipCache file that you were working with.

Start with ‘Capture Clips’ set to enabled:
If enabled, clips will be captured immediately after ClipCache has loaded.

Start with the window hidden:
If enabled, the ClipCache main window will initially be shown as a hidden window. You will still be made 
aware of the presence of ClipCache by the system tray icon.



Options: Advanced

Quick selected up:
This system wide hotkey places the item just above the currently selected item, onto the clipboard. The 
main window does not need to be open. A tool-tip will appear just below the mouse pointer showing the 
name of currently selected item.    See also How To Use Quick Select.

Quick select down:
This system wide hotkey places the item just below the currently selected item, onto the clipboard. The 
main window does not need to be open. A tool-tip will appear just below the mouse pointer showing the 
name of currently selected item. See also How To Use Quick Select.

Do not store text clips exceeding N bytes:
If enabled, text clips exceeding N bytes will not be captured. Useful if you are copying/pasting large 
amounts of text and you do not wish to waste disk space.

Do not bitmap clips exceeding N bytes:
If enabled, bitmap clips exceeding N bytes will not be captured. Useful if you are copying/pasting large 
images and you do not wish to waste disk space.
 
Move duplicate clip items to trash:
If enabled, captured clips are compared against existing clips within the active group. If any are found the 
older duplicate clips are moved to trash.

Automatically save the index file every N minutes
Catpured clips are immediately added to the ClipCache data file (.DAT), however, the index (.IDX) file’s 
contents is held in working memory (for speed). The index file is updated when the user terminates 
ClipCache, or when manually choosing File | Save. On the event of a system crash, all your clips would 
not be available next time ClipCache starts, because it wasn’t able to save the index file. This option 
allows you to specify how often the index file should be automatically saved – offering peace of mind.



Credits

Author: John Williams

A special thanks for testing ClipCache goes to: Kenny Grant, Ted Burrows, Craig Walker, Joe Deller, 
Andrew Goodson and Daniel Ruck.



Version History

1.41

Fixes:
· Fixed a resource problem under Windows95

1.40

Features:
· Item sorting, sort by Name, Size, Format, Date (default.)
· Advanced merge allows ordering and insertion of newline between clips.
· Text append catpure mode (with ‘append mode’ tray icon.)
· Edit existing text clips.
· Create new (empty) text clips.
· Added ‘Edit’ to the right click menu of the item pane (text clips only.)
· Added a ‘Compact’ command to the file menu.
· Accelerator for ‘Delete’ is now just the delete key and not Shift+Delete
· Help menu now has a Web submenu.
· Minor user interface modifications.

Fixes:
· Fixed a bug didn’t allow bitmaps to be put onto the clipboard from the system tray menu.

1.30

Features:
· Added support for Bitmaps (Device Independent Bitmaps)
· Registered filetype icons are now used for clips item icons
· Trash deletion and compaction operations are now much quicker
· Added an option to not capture bitmaps larger than N bytes
· Added an option to allow autosaving of the database every N minutes
· Hide application is now available    on the File menu (accelerator Escape)
· Switch panes is now available on the View menu (accelerator Tab)
· Save is now available on the File menu, which allows manual saving of the current database
· Re-arranged the options startup dialog more logically
· Increased quick select tooltip display time
· Hotkey box for items is now larger, so longer hotkey combinations can be viewed
· Tray Icon now only requires one click to display the main window

Fixes:
· Fixed a bug that displayed an underline character in item/group property sheets when the 

item/group names included an ampersand
· When using quick select hotkeys, the first and last items are now correctly displayed as a tooltip
· Minor bug fixes

1.20

Features:
· Hotkeys may be assigned to clip items via the Item Properties
· The font used to display text clips is now configurable
· Filtering of items that have been assigned hotkeys
· Force a display refresh
· Item Properties now contains the window title from which the clip was copied



· Group name is displayed in the QuickSelect tool tip
· Increased the maximum number of item displayed on the system tray
· Tidied up dialogs (ie: use of commas within large numbers etc.)

Fixes:
· Fixed a bug that caused a crash at startup if 'AutoLoad Recent' was enabled and the file didn't 

exist
· Fixed a bug that caused ClipCache to consume more memory than required
· Fixed a bug that corrupted clips if an item was deleted and moved from Trash to another group
· Removed the ability to select multiple groups

1.00

Initial Release



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



How to . . .
Capture a window image
Get the most out of ClipCache
Use the system tray
Avoid capturing large clips
Maintain the size of each group
Maintain the size of the database
Organise items
Rename items
Make use of Quick Select
Switch between Group and Item pane
Hide the main window
Terminate clipcache
Retrieve frequently used clips



Capture a window image

Make the window you want to capture active. Press Alt+PrintScreen key on the keyboard. 
The print screen key is usually marked as ‘PrtSc.’

To capture the whole screen, just press PrintScreen.



Use The System Tray

Right clicking on the ClipCache icon in the system tray will bring up a menu. The menu is 
split into two areas. The upper area gives quick access to several operations such as 
‘Options’. The lower area displays the currently active group name, and several items that 
belong to that group. Clicking on any of those items will put that item onto the clipboard, 
ready for pasting into you application.



Avoid Capturing Large Clips

Enable ‘Text clips exceeding N bytes are not stored’ and specify a value of the desired size in
the advanced options page. 



Renaming Groups and Items

Select the group or the item, then choose Tools | Rename.



Switching Panes

Press the TAB key to switch between group and item panes in the main window.



Hiding The Main Window

· To hide the main window when ClipCache starts, see the general options.
· To hide the main window without copying anything to the clipboard, press the 

ESCAPE.
· To automatically hide the main window after putting an item onto the clipboard, see 

the general options.



Terminating ClipCache

The usual close window button does not terminate ClipCache. It minimises the window to 
the system tray. To exit ClipCache choose File | Terminate ClipCache.



Organising Items

· To structure and organise your items into groups, select the items you wish to move, 
then drag then to the desired group.

· If you are going to be copying objects with a specific topic (ie: research notes from 
various web pages) to the clipboard, it would be best to make a new group and make 
it the active group.



Maintain Group Size

Enable the group size limits in purge properties for each group. 

and

Enable ‘Purge all groups after opening an ClipCache file’ in options startup page.



Maintain Database size

Follow the procedure for maintaining group size.

and

Regularly clear trash with Tools | Clear Trash. Tip: Enable ‘Clear trash after opening an 
ClipCache file’ in options startup page to automate trash clearing.



Using Quick Select

If you wish to copy and paste several pieces of data from say, a text file, to say, various 
fields in a database form. Simply copy all the items from the text file then switch to the 
database form. Use the ‘Quick select’ hotkeys to put the next (or previous) item onto the 
clipboard. There is no need to keep switching between the text-editor and database form.

Quick selected up:
This system wide hotkey places the item just above the currently selected item, onto the 
clipboard. The main window does not need to be open. A tool-tip will appear just below the 
mouse pointer showing the name of currently selected item.

Quick select down:
This system wide hotkey places the item just below the currently selected item, onto the 
clipboard. The main window does not need to be open. A tool-tip will appear just below the 
mouse pointer showing the name of currently selected item.

See the advanced options for setting up the hotkeys.



Getting The Most Out Of ClipCache

Below is a list of settings which work well with ClipCache.

General options

Enable display of clipped items in tray menu.
Show 10 clipped items in the tray menu.

Enable Keep the window on top.
Enable Hide the window after copying a clipped item.
Activate window with this hotey CTRL + #

Enable Double clicking (or pressing enter) on a clipped item copies it to the clipboard.

Startup options

Enable Automatically open the most recently used ClipCache file.
Enable Purge all groups after opening an ClipCache file.
Disable Clear trash after opening an ClipCache file.

Enable Start with capture clips set to enabled.
Enable Start with the window hidden.

Advanced options

Quick select up hotkey CTRL + [
Quick select down hotkey CTRL + ‘

Disable Text clips exceeding N bytes are not stored.



Retrieve frequently used clips

Right click on a clipped item and select properties.    Click on the HotKey box and press the 
desired hotkey combination. Use the same keypress to place the item onto the clipboard at 
any time. 







New command (File menu)
Use this command to create a new document in ClipCache.

You can open an existing document with the Open command.

Shortcuts
Keys: CTRL+N



Open command (File menu)
Use this command to open an existing document. You can create new documents with the New command

Shortcuts
Keys: CTRL+O



Save (File menu)
Use this command to write any changes made in the database to the database file. This is automatically 
done when you terminate ClipCache or when you choose to open a different database file.

Saving may be done automatically in the advanced options dialog.



Save As command (File menu)
Use this command to save and name the active document.    ClipCache displays the Save As dialog box 
so you can name your document.

There is no need to save your document; this is auctomatically done for you upon exiting ClipCache. You 
may use this command to save your ClipCache data files to a floppy disk or remote computer. This allows
portability of stored slips.



Save Clip (File menu)
Saves the currently selected clip to a file. The format of the file is dependent on the format on the clip. For
example, choosing ‘Save Clip…’ with a text selected will save the clip as a text file.

Note: Currently only saving of Text clips is available.



Compact (File menu)
Reduces the size of the database by removing data represented by permanently deleted items. This is 
known as compaction. Do not confuse this command with compression.

Note: when items are permanently deleted (from the Trash group), the data for the clip is not removed 
from the data file immediately. Instead, it is made invisible. Simply put, deleting data from the data file 
involves re-calculation of many clip items as they will live at new positions in the data file after the delete 
operation. This command gives you control over when the compaction should take place.



1, 2, 3, 4 command (File menu)
Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you 
closed.    Choose the number that corresponds with the document you want to open.



Hide (File menu)
Hides the main application window.

Shortcuts
Keys: Escape



Terminate ClipCache command (File menu)
Use this command to end your ClipCache session. 

This menu item is also available by right clicking on the ClipCache tray icon. 



Cut command (Edit menu)
Use this command to remove (move to trash) the currently selected data from the document and put it on 
the clipboard.    This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)
Use this command to copy selected data onto the clipboard.    This command is unavailable if there is no 
data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)
Use this command to insert a copy of the clipboard contents into the currently active group. This 
command is unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Select All command (Edit menu)
Use this command to select all the items in the item pane.



Invert Selection command (Edit menu)
Use this command to invert the selection of items in the item pane.



Toolbar command (View menu)
Use this command to display and hide the Toolbar, which includes buttons for some of the most common 
commands in ClipCache, such as File Open.    A check mark appears next to the menu item when the 
Toolbar is displayed.



Status Bar command (View menu)
Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button. A check mark appears next to the menu item when the 
Status Bar is displayed.



Large Icons command (View menu)
Use this command to display the items in the item pane as large icons.



Small Icons command (View menu)
Use this command to display the items in the item pane as small icons.



List command (View menu)
Use this command to display the items in the item pane as a list.



Details command (View menu)
Use this command to display the items in the item pane in detail (report).



Switch Pane (View menu)
Use this command to swtich between the Group, Item and Preview panes.

Shortcuts
Keys: Tab



Set Font command (View menu)
Use this command to change the font used to display text clips in the preview pane.



Refresh command (View menu)
Use this command to refresh all the panes (group, item and preview.)

Shortcuts
Keys: F5



HotKey Items Only command (View menu)
Use this command to filter out clipped items that have been assigned a hotkey. This allows easy browsing
of items with assigned hotkeys.

Shortcuts

Toolbar:



Properties command (Tools menu)
Displays a properties dialog box for either the select group or the selected item(s).

Group: General
Purge

Item: General

Shortcuts

Toolbar:
Keys: ALT+Enter



Delete command (Tools menu)
Deletes the selected group or item by moving it into the trash group. Note: deleting items from the trash 
group permanently deletes the item(s).

In versions previous to ClipCache 1.40, Shift had to be pressed at the same time as Delete. This is no 
longer a requirement. In fact, doing so will result in no delete operation.

Shortcuts

Toolbar:
Keys: Delete



Rename command (Tools menu)
Renames the selected group or item.

Shortcuts

Toolbar:
Keys: F2



New Group command (Tools menu)
Creates a new group in which to store items. You may edit the properties for the group as required.

Shortcuts

Toolbar:
Keys: CTRL+G



Activate Group command (Tools menu)
Makes the selected group, the active group.

Shortcuts
Keys: Hit ENTER on the selected group.



Purge All Groups command (Tools menu)
Purges all groups. Each group’s purge properties are taken into consideration. Any items that exceed the 
groups’ settings will be moved to trash.



Clear Trash command (Tools menu)
Permanently delete all items in the trash group.
 
Shortcuts

Toolbar:



Create Text Clip (Tools menu)
Creates a new and empty text clip ready for editing. This may be used to easily add text clips without the 
need to open a text editor, write the text and finally select and copy it to the clipboard.

Shortcuts

Toolbar:
Keys: CTRL+T



Edit Text Clip (Tools menu)
Allows the editing of existing text clips. You may also choose to keep the original version of the clip by 
choosing ‘Add this text as a new clip item’ from the editor dialog.

Shortcuts

Toolbar:
Keys: CTRL+E



Merge Text Clips (Tools menu)
Use this command to merge together several text clips into one single text clip. You will be shown a dialog
box with a list of selected clips. Use the ‘up’ and ‘down’ buttons to order the clips accordingly.

Note: At least 2 text clips must be selected for this comand to be available.



Append Text Capture Mode (Tools menu)
When ClipCache is in append text capture mode, when you next copy text to the clipboard, ClipCache will
append the text to the currenly selected    text clip. The contents of this new clip will then be placed onto 
the clipboard. This will give the effect of actually appending text to the clipboard.

Note: Because this mode causes ClipCache to work differently when capturing text, the system tray icon 
is modified to alert you of this.



Capture Clips command (Tools menu)
Enables/disables the capturing of clips. The system tray will show a no-entry sign when capturing is 
disabled.

This menu item is also available by right clicking on the ClipCache tray icon.



Options command (Tools menu)
ClipCache’s main options are split into three areas:

· General
· Startup
· Advanced

This menu item is also available by right clicking on the ClipCache tray icon. 



Help Topics command (Help menu)
Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using ClipCache and various types of reference information.    



Web (Help menu)
Lauches your default browser with the relevant URL.



Web (Help menu)
Lauches your default browser with the relevant URL.



Web (Help menu)
Lauches your default browser with the relevant URL.



About command (Help menu)
Use this command to display the copyright notice and version number of your copy of ClipCache.




